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Preface

Microsoft® Outlook 2016 is a personal information management application that 
provides tools to send, receive, and manage email; organize schedules and events; 
keep track of contacts; and maintain to-do lists and other collections of notes. 
Organizing and managing information related to your personal and professional 
activities is an essential skill in today’s fast-paced world. Often, you can be juggling 
messages, appointments, contacts, and tasks related to home, work, and volunteer 
projects throughout the day, seven days a week! 
 After successfully completing a course using this textbook, you will be able to 
do the following:

• Compose, send, and respond to email messages, including attachments
• Find, arrange, organize, manage, and archive email messages
• Schedule appointments, events, and meetings and maintain calendars 
• Manage contact information and coordinate the data with email and 

scheduling functions
• Maintain to-do lists and assign tasks to others
• Keep track of activities, short reminders, and ideas
• Customize the Outlook environment and integrate data among the 

Outlook components and with Microsoft Word to meet individual 
information needs

Chapter Features
This book, Microsoft® Outlook 2016, is designed to teach through a read-and-do 
approach and provides figures that show what the computer screen will look like at 
key steps in the execution of a feature. Throughout every chapter, Outlook tools and 
commands are presented in a clear, straightforward way. 

• Each short section of reading is followed by a detailed exercise that 
provides immediate practice using the new feature. 

• Interactive tutorials (accessed through the links menu in the ebook) offer 
additional hands-on practice with key features. 

• Quick Steps boxes in the margins provide easy-to-read summaries of the 
steps to follow in performing given skills. 

• Exchange Server notes, Tips, Outlook on the web boxes, and Outlook.com 
boxes deliver additional information on special features and topics. 

 Gradually, these elements help you build information management skills along 
with confidence in using the software. At the end of each chapter, review, rein-
forcement, and assessment activities provide checkpoints to ensure mastery of the 
chapter topics.
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Creating a Signature
A signature is a closing that is automatically inserted at the bottom of each sent 
message. Signature text usually includes sender contact information, such as name, 
title, department, company name, and phone numbers. Some people include 
additional information, such as office hours, an assistant’s name, and/or a security 
disclaimer message. Another use of signatures is to add a company logo or motto 
to the ends of messages. 
 An advantage to creating a signature is that each message contains a consistent 
closing. You can create multiple signatures for the different types of messages 
that you send. For example, create one signature for mail sent to people outside 
your organization that contains your complete contact information and another 
signature for mail sent to people within your organization that contains only your 
title and extension number.
 To create a signature, open a message window and click the Signature button 
in the Include group on the Message tab. Click the Signatures option to open 
the Signatures and Stationery dialog box. Click the New button, type a name 
to associate with the signature text, and then click OK. Type and format the 
signature text in the Edit signature text box and then click OK.

Tutorial

Creating a Signature

Signature

Flag a message by moving the mouse into the message header above the time 
the message was received, and then click the flag icon that appears to assign 
a Today flag. Right-click the flag icon to set a different flag. A Mark as read 
or Mark as unread icon appears in the same area. You can also delete the 
message or use the push pin icon to pin the message to the top of the list.

Flagging Messages and Changing Read Status  
in Outlook on the web

At Outlook.com, point to a message in the message list to display the icons used 
to change the read status or to flag the message. Two other icons that appear are 
used to delete the message or pin the message to the top of the folder.

Flagging Messages and Changing Read Status  
at Outlook.com

Click here to flag a message. Right-
click to choose the flag option.

Click here to change the read status.

Create a Signature
1. Open message 

window.
2. Click Signature 

button in Include 
group on Message 
tab.

3. Click Signatures.
4. Click New button.
5. Type name for 

signature.
6. Click OK.
7. Type signature  

text and format  
as desired.

8. Click OK.

uick Steps

You can also flag/
unflag, change 
the read status, 
or pin/unpin the 
message from the 
More commands 
drop-down list.

Click here to flag 
the message.

Click here to change 
the read status.

Click here to delete 
the message.

Click here to pin the message 
to the top of the folder.

Textbook Elements
The following interactive, read-and-do features in each chapter will help you 
master the Outlook 2016 concepts and skills taught in this course.

1. Preview. Read the performance objectives on the opening page of 
the chapter to identify the skills you will learn.

2.  Precheck. Test your knowledge of the chapter content by taking the 
Precheck quiz. Use the results to help focus your study on the topics 
and skills you need to learn. The Precheck quizzes are accessed from 
the links menu in the Workbook ebook. SNAP users should go to their 
SNAP Assignments page to complete these quizzes. 

3. Prepare. For Chapters 1 and 4, copy the data files necessary to 
complete the chapter exercises.

4. Motivate. Read the chapter introduction to learn how mastering the 
skills covered in the chapter will help you accomplish key tasks.

11

1
CHAPTER

Precheck

Check your 
current skills to 
help focus your 
study.

Performance Objectives
Upon successful completion of Chapter 1, you will be able to:

 1 Identify Outlook components and display folder contents

 2 Compose, send, open, and print messages

 3 Reply to, forward, and delete messages

 4 Attach files to messages and manage file attachments

 5 Add cc and bcc recipients to messages

 6 Apply formatting options to text in messages

 7 Assign importance, sensitivity, tracking, and delivery options to messages

 8 Apply follow-up flags to messages

 9 Mark messages as read or unread

 10 Create signatures

 11 Use the Tell Me feature to access Help resources

Communicating  
with Email

Microsoft Outlook is an application that is referred to as a personal information 
manager (PIM) program. Personal information management programs organize 
items such as email messages, appointments and meetings, contacts, to-do lists, 
notes, and journal entries. Data stored within Outlook can be integrated to and 
from individual Outlook modules and/or other Microsoft Office applications, 
such as Word and Access. In the workplace, Outlook provides collaborative tools 
such as group scheduling, scheduling assistance, meeting resource scheduling, data 
sharing, role delegation, and task assignment and management. In this chapter, 
you will explore the basic features of Outlook and the Mail module that is used for 
communicating using email messages.
 Electronic mail (email) is communication between individuals by means of 
sending and receiving messages electronically. While text messaging is popular for 
brief messages, email is still used for longer messages and is the primary means of 
communication in the workplace.

Three student data files are required for this chapter. Before beginning the chapter 
exercises and assessments, download the files by going to the Ancillary Links menu 
on this page in your ebook, clicking the Student Data Files link, and saving the files  
to your storage medium (such as a USB flash drive). 

Data Files

If you are a SNAP 
user, launch the 
Precheck and the 
Tutorial from your 
Assignments page.

5. Learn (Read). Read the description of each tool or skill 
carefully.

 •  Pay special attention to the button images and screen 
visuals provided.

6. Reinforce. Read each Quick Steps summary in the margin 
to focus on the essential steps for completing a task.
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Opening, Printing, Replying to,  
and Forwarding Messages
Unread inbox messages display with a vertical blue bar at the left of the message 
header and with the subject and time (or date) in bold blue text. The sender’s 
name, the subject, and the first line of message text appear in the message header. 
By default, messages are arranged by date with the most recent message displayed 
at the top of the list.
 If you are online when a new message is received, a chime will sound and a 
desktop alert, similar to the one shown in Figure 1.3, will appear near the bottom 
right of your screen. Click the alert to open the message or rest the pointer over 
the alert to keep it visible longer.

Reading and Printing Messages
In many cases, you can read, reply to, or forward a message directly from the 
Reading pane. If the Reading pane is turned off on the computer you are using, 
click the View tab, click the Reading Pane button in the Layout group, and then 
click Right at the drop-down list to show the pane in the same location as shown 
in Figure 1.4. Open a long message by double-clicking the message header in the 
Content pane to open the message in a window similar to the window shown in 
Figure 1.5 on page 20.
 Print the active message by clicking the File tab, clicking Print at the backstage 
area, and then clicking the Print button. Most people add the Print button to the 
Quick Access Toolbar if they often print messages by clicking the Customize Quick 
Access Toolbar button located at the end of the toolbar and then clicking Print.

Print

Figure 1.3 Desktop Alert for New Message Received

If you are using Outlook connected to a 
server running Microsoft Exchange Server, 
the name of your mailbox on the server 
displays here instead of the email address.

A feature called inline replies 
allows you to reply or forward 
a message directly from the 
Reading pane.

The subject and time 
for an unread message 
display in bold blue text.

Figure 1.4 Viewing Messages in the Reading Pane

Print a Message
1. Select or open 

message.
2. Click File tab.
3. Click Print.
4. Click Print button.
5. If necessary, close 

message.
Reply to a Message
1. Click Reply button 

in Reading pane.
2. Type reply 

message.
3. Click Send.
Forward a Message
1. Click Forward 

button in Reading 
pane.

2. Type recipient’s 
address.

3. Type message.
4. Click Send.

uick Steps

7. Apply (Do). Complete each exercise to gain hands-on practice with 
the skill you just learned.

 •  Before beginning an exercise, notice its title, which indicates your 
learning goal.

 •  Some exercises have special notes at the beginning. Be sure to 
read them and follow the directions.

 •  Follow the steps in each exercise carefully. Note that numbered 
callouts on the screen visuals point to what you should see on 
the screen after a particular step. If your screen does not match 
the display, return to that step and make sure you completed it 
correctly or return to the previous step and try again.

 •  View Check Your Work images in locked PDFs to see what your 
completed exercise should look like.

 •  At the completion of an exercise, leave Outlook open unless directed 
otherwise. In the next exercise, you will pick up where you left off.

 Complete each interactive tutorial to follow simple instructions as 
they guide you through the steps in a skill and then practice the skill 
on your own with optional help. SNAP users should go to their SNAP 
Assignments page to complete these tutorials. 
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Note: Make sure you have copied the student data files for this chapter to your storage medium  
before completing this exercise.

 1. With Inbox active, click the New Email button in the New group on the Home tab.
 2. With the insertion point positioned in the To text box, type the email address for the 

recipient.
 3. Press Tab or click in the Cc text box and type 

the email address of the student you forwarded a 
message to in Exercise 3, Step 3.

 4. Click the Options tab and then click the Bcc 
button in the Show Fields group. Note: Skip 
this step if the Bcc text box is already visible in your 
message window.

 5. Click in the Bcc text box and then type the email 
address of another student in your class.

 6. Press Tab or click in the Subject text box and then type Social Media Privacy Tips.
 7. Press Enter or click in the message text box and then type the following message text:

First name, [Substitute the first name of the message recipient for First name.]

I created this document with a few tips on how to protect your personal information 
when communicating using social media. Let me know if you have additional tips I 
should add to the list.

 8. Press Enter two times at the end of the message text and then type your name as the sender.
 9. Attach the Word 

document named 
SocialMediaPrivacy.
docx to the message 
by completing the 
following steps:

 a. Click the Message 
tab and then 
click the Attach 
File button in the 
Include group.

 b. Click Browse This PC 
at the drop-down 
list. At the Insert File 
dialog box, navigate to 
the location on your 
storage medium where the student data files are 
stored for Chapter 1, and then double-click the 
file SocialMediaPrivacy.docx in the Content pane.

 c. Look below the Subject text box. Notice the 
Attached field added to the message with the 
name of the file and the file size displayed with a 
Word document icon.

 d. Click the File tab in the message window, click 
Print, and then click the Print button.

 10. Click Send.

Exercise 5 Attaching a File to a Message and Sending a Copy to Someone Else

4

3

Check Your Work

9c

10

5

7-8

6
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 •  Exchange Server notes 
describe key differences if 
your version of Outlook is 
connected to a server running 
Microsoft Exchange Server.

9. Review. At the end of the chapter, read 
the review features before you complete 
the workbook activities and assessments.

 •  The bulleted points in the Chapter 
Summary review essential chapter 
content.

 •  The entries in the Commands Review 
identify key Outlook features and their 
associated buttons, button locations, 
and keyboard shortcuts.

10. Assess. Complete the Workbook activities 
and assessments to confirm that you have 
mastered the chapter content.
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Chapter Summary
■	 Information in Outlook is organized in folders grouped by the modules 

Mail, Calendar, People, and Tasks. Click the module text label or icon on the 
Navigation bar to view the corresponding contents in the Content pane.

■	 Outlook can be used as an email client that is connected to an Exchange Server 
or Internet mail server that supports the POP3 or IMAP mail protocol.

■	 Use the New Email button in the New group on the Home tab to create and 
send an email message.

■	 Select a message header in the Content pane to read the message text in the 
Reading pane.

■	 Print a message using the Print button on the Quick Access Toolbar or at the 
Print backstage area.

■	 Reply to or forward a message using buttons in the Reading pane or in the 
Respond group on the Message tab in a message window.

■	 Deleted messages are moved from the current folder to the Deleted Items folder, 
where they remain until you empty that folder.

■	 Files are routinely attached to email messages. A file attached to a message can 
be previewed in the Reading pane or opened in Protected view in the source 
application.

■	 Use buttons on the Attachment Tools Attachments tab to manage a file 
attached to a message.

■	 Send copies of a message to other individuals using the Cc (carbon copy) and 
Bcc (blind carbon copy) fields. The identities of bcc recipients are kept private.

■	 Add the Bcc field to a message with the Bcc button in the Show Fields group on 
the Options tab in a message window.

■	 Select message text and apply formatting options using buttons on the Mini 
toolbar, Basic Text group on the Message tab, or Format Text tab of a message 
window.

■	 Embed a copy of a picture within a message or add a hyperlink using the 
Pictures or Hyperlink button on the Insert tab in a message window.

■	 Click the High Importance or Low Importance button in the Tags group on the 
Message tab to indicate to the recipient the message’s priority. Messages tagged 
High Importance show a red exclamation point in the message header.

■	 Tracking options such as voting responses, delivery receipts, and read receipts 
are added to messages with buttons in the Tracking group on the Options tab.

 d. Read the steps for saving a received message as a file. Scroll down if necessary to read 
the information about changing the default file format for saving messages, and then 
close the Help task pane when finished.

 2. Click to select the message header in the Content pane with the subject text Social Media 
Project.

 3. Click in the Tell Me text box, type save message, and then click the Save As option in the 
drop-down list. At the Save As dialog box, navigate to the drive and folder for your storage 
medium, and then click the Save button.

 4. If necessary, press the Esc key to close the Tell Me text box.
Check Your Work
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■	 Open the Properties dialog box for a message to add additional message 
options, such as a private or confidential sensitivity setting, or to redirect 
replies to another email address.

■	 Flag a message for follow-up to remind yourself that it requires further action. 
Use the Follow Up button in the Tags group on the Home tab to flag the 
selected message. Flagged messages display with a red flag icon.

■	 Change the read status of a selected message with the Unread/Read button in 
the Tags group on the Home tab. Marking a message as unread is another way 
to make it stand out in the message list as requiring further action.

■	 A signature is text that is automatically added to the end of each message. 
Create a new signature using the Signature button in the Include group on the 
Message tab in a message window.

■	 The Tell Me feature is used to directly access a command or look up 
information in a Help task pane or Smart Lookup task pane.

Commands Review
FEATURE BUTTON RIBBON TAB AND GROUP, OR OTHER METHOD SHORTCUT

Attach file to message Message, Include OR Insert, Include

Attach High Importance 
option

Message, Tags

Change read status
Home, Tags OR Message, Tags (to mark open 
message as unread)

Ctrl + U (Unread)
Ctrl + Q (Read)

Create new mail message Home, New Ctrl + N

Create new signature File, Options, Mail OR Message, Include

Delete message Home, Delete
Ctrl + D, OR;  
Delete key

Embed picture in message Insert, Illustrations

Flag message Home, Tags OR Message, Tags

Forward message
Forward button in Reading pane; Home, Respond; OR 
Message, Respond

Ctrl + F

Insert hyperlink
Type valid web address then press spacebar OR 
Insert, Links

Ctrl + K

Open Outlook
Start menu; click icon on taskbar; OR double-click 
icon on desktop

Open Properties dialog box 
for additional message 
options

Message, Tags OR Options, Tracking

Print active message Print button on Quick Access Toolbar OR File, Print Ctrl + P

8. Extend. Go beyond the basics by learning interesting and 
relevant information in special features.

 •  Outlook on the web features show how tasks are 
accomplished using the Outlook web application for 
Exchange Server 2016 clients.

 •  Outlook.com features illustrate differences between 
the desktop and online versions of Outlook.
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click the Send/Receive All Folders button  in the Send & Receive group, or click 
the Send/Receive All Folders button on the Quick Access Toolbar to send the message 
immediately.

 b. Click Sent Items in the Folder pane. Messages that have been delivered to the mail server 
are displayed in the Content pane.

 3. Click Inbox in the Folder pane to redisplay the Inbox folder contents.

Outlook.com is Microsoft’s free web-based email 
service. Open a browser window, type the URL 
outlook.com, and then sign in using your email 
address and password. Click the 
New button in the Menu bar at 
the top of the screen. Type the 
recipient’s email address next to 
the To button. Click Add a subject 
and type the subject text. Click 
the placeholder text Add a message 
or drag a file here and then type 
the message text. Click the Send 
button when finished.

Composing a New Email Message at Outlook.com

Users connected to an Exchange server can create a new message from any 
device with Internet access. Open a browser window and type the URL 
provided by your mail administrator—for example, https://server.net/owa. 
Log in with your email address and password. At the Outlook on the web 
screen click the New button in the Menu bar at the top of the screen. Type 
the recipient’s name or email address in the To field, type the subject in the 
Subject field, type the message in the white area below the toolbar, and then 
click the Send button.

Check Your Work

Composing a New Email Message in Outlook on the web

Type the 
recipient’s 
name or 
address, type 
the subject 
and message 
text, and 
then click the 
Send button.

Click here to start 
a new message.

To send to someone on the same internal 
Exchange server, just type their name.
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 Messages with the High Importance option attached display a red exclamation 
point at the right of the sender’s name in the Content pane. In the Reading pane 
for the message, an Information bar displays below the sender’s name informing the 
recipient of the options that have been assigned to the message, as shown in Figure 
1.7 on page 33.
 When a message has been sent to you with a read receipt attached, you will be 
notified that a read receipt has been requested by the sender unless you have modified 
the default options in the Tracking section of the Outlook Options dialog box. An 
example of a read receipt is shown in Figure 1.8 on page 33.
 Some Internet mail service providers do not support email tracking options, 
which means voting buttons and/or read receipts are not processed. If you do 
not receive a read report after sending a message with a read receipt attached, it 
does not necessarily mean that the message was not opened by the recipient. One 
possibility is that the recipient’s mail service or mail application does not support 
read receipts. Another possibility is that the recipient selected No when prompted 
to send the read receipt back to you. Similarly, if you send a message with voting 
buttons attached and do not receive response messages, it may be because some 
recipients did not see the voting buttons when they opened the message.

 5. Press Enter two times at the end of the message text and then type your name as the sender.
 6. Tag the message as important and confidential and assign a 

delivery option by completing the following steps:
 a. Click the High Importance button in the Tags group on the 

Message tab. This button is a toggle; when the feature is active, 
the button is shaded with a light gray background.

 b. Click the Properties dialog box launcher  located at the bottom 
right of the Tags group.

 c. Click the button that displays Normal 
next to Sensitivity in the Settings section 
of the Properties dialog box and then 
click Confidential at the drop-down list.

 d. Click the Close button.
 e. Click the Options tab.
 f. Click to insert a check mark in the Request a Read Receipt check box in the Tracking group.
 7. Print the message from the message window and then send the message.

6e 6f

7

6a

6b

This option was changed 
in Step 6a by the High 
Importance button.

6c

Check Your Work

If you are using 
Outlook as an email 
client connected to 
a server running 
Microsoft Exchange 
Server, you can review 
the voting responses. 
Open the message 
from Sent Items in 
which you included 
voting buttons and 
click Tracking in the 
Show group on the 
Message tab.

Exchange 
Server
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FEATURE BUTTON RIBBON TAB AND GROUP, OR OTHER METHOD SHORTCUT

Reply to all recipients
Reply All button in Reading pane; Home, Respond;  
OR Message, Respond

Ctrl + Shift + R

Reply to message
Reply button in Reading pane; Home, Respond;  
OR Message, Respond

Ctrl + R

Show Bcc field Options, Show Fields

Use Tell Me feature Click in Tell me text box Alt + Q

Workbook

Chapter study tools and assessment activities are available in the Workbook 
pages of the ebook. These resources are designed to help you further 
develop and demonstrate mastery of the skills learned in this chapter.

 •  Tips provide additional 
information on specific topics. 20 Outlook 2016     Chapter 1  |  Communicating with Email

Replying to a Message
When you click the Reply button or Reply All button in the Reading pane or 
Respond group on the Message tab, the sender’s email address is automatically 
entered in the To text box and RE: is inserted in front of the Subject text. The 
original message text is included below the reply text so that the reader will see 
the source message. This set of messages is referred to as a thread and is beneficial 
to someone who sends or receives several messages in a day and may not 
immediately recall what she or he has already sent to you.
 If you are replying to a message that was sent to multiple recipients and you 
would like all of them to read your reply to the sender, click the Reply All button. 
Doing so will automatically insert the sender’s email address and the email 
addresses of the other recipients of the original message in the To text box.

Forwarding a Message
When you click the Forward button in the Reading pane or a message window, 
the insertion point is positioned in the To text box and FW: is inserted in front of 
the Subject text. The original message text is included below the forward message 
text so the reader can read the threaded text.
 Type the email address of the person to whom you want to forward the 
message and, if necessary, include a few explanatory lines of text above the 
original message for the benefit of the recipient.
 Be cautious when forwarding a message that you have received to someone 
else. Make sure that the sender would not object to another person reading the 
message. Keep in mind that the sender intended the message to be a private 
communication between you and him or her. If the content contains sensitive 
information, check with the sender first before you forward the message. A good 
practice to follow is that if you are in doubt, do not forward the message.

Figure 1.5 Opened Message Window

Click here to type a 
reply to the sender.

Click here to 
type a reply to all 
recipients of the 
original message 
when that 
message was sent 
to more than one 
person.

Click here to 
send the original 
message to 
someone else.

Reply

Reply All

Forward

If you are 
forwarding information 
to several people who 
do not know each 
other, put the email 
addresses in the Bcc 
field (see page 24) 
to protect everyone’s 
privacy. Delete any 
email addresses 
that appear in the 
message for the same 
reason.

TIP

Exercise good 
judgment when 
using Reply All. Make 
sure all of the other 
recipients really need 
to see your response.

TIP
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Study Tools offer multimedia and text-based review of the concepts, features, and 
skills taught in a chapter. These tools are accessed from the links menu in the 
Workbook ebook. 

The Concepts Check completion activities test your recall of key points about 
Outlook tools and features. These activities are accessed from the links menu in 
the Workbook ebook. SNAP users should go to their SNAP Assignments page to 
complete these activities.

A Recheck quiz at the end of each chapter enables you to recheck your 
understanding of the chapter content. You may recheck your understanding at any 
time and as many times as you wish. The Recheck quiz is accessed from the links 
menu in the Workbook ebook. SNAP users should go to their SNAP Assignments 
page to complete the Recheck quizzes. 

The Skills Assessments provide directions for completing tasks but do not tell 
you how to perform every step. If you can complete these workbook exercises 
successfully, then you have mastered the chapter content.

Workbook Elements
Access the Workbook ebook through the links menu in your ebook. The Workbook 
ebook provides a variety of materials you can use to check your understanding 
of the concepts and features covered in the textbook. Some activities are 
also offered in SNAP. Students using SNAP should go to their SNAP 
Assignments page to complete those activities.

WB-1

1
WORKBOOK CHAPTER

Study tools for this chapter include a slide presentation with audio support and a 
document listing all Quick Steps and Tips. Use these resources to help you further 
develop and review skills learned in this chapter.

Check your understanding of the Outlook tools used in the chapter by completing 
this identification exercise. If you are a SNAP user, launch the Concepts Check 
from your Assignments page.

Check your understanding of the concepts and features covered in the chapter 
by taking this quiz. If you are a SNAP user, launch the Recheck from your 
Assignments page.

Skills Assessment
Note: Check with your instructor before completing these assessments to see if he or she wants 
you to submit your work in hard copy by printing as instructed or in electronic format.

Creating and Sending a Message
 1. Make sure Inbox is active.
 2. Create a new message to the student you have been exchanging messages with 

in this chapter as follows:
 a. Type Social Media and the Remix Culture as the subject text.
 b. Type the following message text and add an appropriate salutation at the 

beginning:
I just read an article about remix culture. Remix culture refers to the 
acceptance by society of the content generation practice in social media 
sites that uses, changes, or otherwise integrates the work of a copyright 
holder.
While social media has provided a venue to showcase creativity, 
discussion is ongoing with respect to the protection of copyright holders 
from unauthorized use of their works.
Should we include this topic in our social media essay?

 3. Print and then send the message.

Replying to, Forwarding, and Deleting Messages
 1. With Inbox the active folder, select the message with the subject Social Media 

and the Remix Culture, which you should receive at the end of Assessment 1.
 2. Send the following reply to the originator of the message and add an 

appropriate salutation and your name as the sender:
Yes, I think we should include this topic in our essay. If I find any articles 
related to the remix culture, I will send them to you.

Assessment

1

Assessment

2

Communicating  
with Email

Study Tools

Concepts Check

Recheck

Course Components
The Microsoft® Outlook 2016 textbook contains the essential content you will need 
to master the features and skills covered. Additional resources are provided by the 
following digital components.

SNAP Web-Based Training and Assessment  
for Microsoft® Office 2016
SNAP is a web-based training and assessment program and learning management 
system (LMS) for Microsoft Office 2016. SNAP offers rich content, a sophisticated 
grade book, and robust scheduling and analytics tools. SNAP courseware supports 
the Outlook 2016 content and delivers interactive tutorials that increase skills-
focused moments with guided training and measured practice. SNAP includes 
a quiz for each chapter and a final exam for the course, plus an item bank that 
can be used to create custom assessments. SNAP provides automatic scoring and 
detailed feedback on exercises and assessments to help identify areas where addi-
tional support is needed, evaluating student performance at both the individual 
level and the course level. The Outlook 2016 SNAP course content is also available 
to export into any LMS system that supports LTI tools. 
 Paradigm Education Solutions provides technical support for SNAP through 
24-7 chat at ParadigmEducation.com. In addition, an online user guide and other 
training tools for SNAP are available. 
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Student Ebook and Workbook Ebook
The student ebook and Workbook ebook provide access to all program content 
from any device (desktop, tablet, and smartphone) anywhere, through a live 
Internet connection. The versatile ebook platform features dynamic navigation 
tools including a linked table of contents and the ability to jump to specific pages, 
search for terms, bookmark, highlight, and take notes. The ebooks offer live links 
to the interactive content and resources that support the textbook, including the 
data files. The student ebook includes links to the interactive Precheck quizzes, 
interactive tutorials, Check Your Work images in downloadable PDFs, and related 
Workbook ebook.
 The Workbook ebook includes access to Study Tools such as chapter-based slide 
presentations with audio support, and Quick Steps and Tips documents. It also 
provides access to interactive end-of-chapter Concepts Check exercises, interactive 
Recheck quizzes, and Skills Assessments. The Workbook is accessed through the 
links menu on the last page of each chapter in the student ebook. It may also be 
accessed online at ParadigmEducation.com/ebooks or from your SNAP course.
 SNAP users should go to their SNAP Assignments page to complete the 
interactive quizzes, tutorials, and exercises.

Instructor eResources
All instructor resources are available digitally through a web-based ebook online  
at ParadigmEducation.com/ebooks or from your SNAP course. The materials are 
organized by type and also by chapter, and can be previewed from the ebook or 
downloaded. The instructor materials include the following items:

• Grading rubrics and model answers for evaluating responses to chapter 
exercises and Skills Assessments

• A grading sheet and assignment sheets
• Lesson blueprints with teaching hints
• Discussion questions
• A sample syllabus and course planning resources
• An MOS Specialist Objectives chart
• Chapter-based PowerPoint presentations with lecture notes
• A final exam
• A Capstone Project complete with instructions, model answers,  

and a grading rubric

About the Author
Denise Seguin served on the faculty of business at Fanshawe College of Applied 
Arts and Technology in London, Ontario, from 1986 until her retirement from 
full-time teaching in December 2012. She developed curriculum and taught a 
variety of office technology, software applications, and accounting courses to stu-
dents in postsecondary Information Technology diploma programs and Continuing 
Education courses. Seguin served as Program Coordinator for Computer Systems 
Technician, Computer Systems Technology, Office Administration, and Law Clerk 
programs and was acting Chair of the School of Information Technology in 2001. 
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Along with authoring Microsoft® Outlook, 2000 to 2016 editions, she has also 
authored Seguin’s COMPUTER Concepts & Applications with Microsoft Office (first 
and second editions, 2013 and 2016). Seguin has co-authored Our Digital World,  
(first to fourth editions), Benchmark Series: Microsoft® Excel® (2007, 2010, and 2013 
editions), Benchmark Series: Microsoft® Access® (2007, 2010, and 2013 editions), 
Marquee Series: Microsoft® Office (2000 to 2016 editions), and Using Computers in the 
Medical Office (2003 to 2010 editions).
 In 2007, Seguin earned her Masters in Business Administration specializing in 
Technology Management, choosing to take her degree at an online university. She 
has an appreciation for those who are juggling work and life responsibilities while 
furthering their education, and she has taken her online student experiences into 
account when designing instructions and assessment activities for this textbook.
 In 2016, Seguin returned to part-time teaching at Fanshawe College choosing 
to teach online courses. She returned to teaching to connect with today’s virtual 
students and to keep up to date with best practices in online teaching.
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Getting Started

Microsoft Outlook 2016 is part of the Microsoft Office suite, which includes 
Word, Excel, PowerPoint, OneNote, Access, and Publisher. The Office suite is 
sold in various collections such as Office Home & Business 2016, Office 365 
Home, and Office Professional 2016 to name a few. The software is included 
as part of the Office 365 subscription paid monthly or annually, or as one-time 
purchased software for installation on one PC only. Outlook is also included 
in the Office Home & Business 2016 for Mac collection and as an app for 
Android or Apple smartphones.
 Outlook.com is the free, web-based version of Outlook for accessing email, 
calendar, contacts, and tasks. Outlook.com links to the data stored on your 
desktop edition of Outlook so that you can view the same data from any other 
device connected to the Internet.
 In the workplace, Outlook is often used in conjunction with a Microsoft 
Exchange Server to provide workplace collaboration and sharing features not 
available to home users. Those who use Outlook connected to an Exchange 
server may choose to use Outlook via their web browser and the Outlook Web 
App called Outlook on the web.
 The user interface for Outlook when you are using the software from an 
edition designed for a PC, a Mac, a smartphone, or a web browser may vary. 
Some editions may also offer a limited set of commands or options. The 
desktop edition offers the complete set of commands and options.

Using Outlook 2016  
with This Textbook 
This textbook is intended for use with the desktop edition of Microsoft 
Outlook installed on a PC running Windows. If you have another edition of 
Microsoft Outlook or are using Outlook on a Mac, you can still use this text-
book to learn about the features and options. However, be aware that the inter-
face may vary from the illustrations shown in this book and in some cases, func-
tionality may be limited or an option may not be available.
 Screen captures in this book were created using the Windows 10 operating 
system and a screen resolution display setting of 1920 x 1080. Your resolution 
may differ and should be optimized for your display size and personal prefer-
ences. Be aware that some screens may not match the illustrations in this book 
for displays set to a resolution other than 1920 x 1080 and/or if the Outlook 
window has been resized to a width that causes the ribbon to display buttons 
differently. For example, a button may display with an icon and text label below 
the icon, an icon and text label adjacent to the icon, or an icon only, depending 
on the window size.
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Adding a Picture  
to Your Outlook Profile
People like to display photos next to their name in email messages and in the 
People panes of other Outlook items. The Exchange server administrator usually 
configures Outlook to populate each person’s photograph from an employee 
database to the person’s contact record in the global address list (GAL). An indi-
vidual can also add or change the photograph associated with the Exchange server 
mailbox using Outlook on the web. If you are not connected to Outlook where the 
mail administrator automatically populates the photographs for each person, you 
can add your picture to your Microsoft account profile so that the same image dis-
plays in all Microsoft applications, such as Word and Excel, as well as Outlook.
 The various methods for adding a picture are described next in this introduc-
tion because of the complexity of writing a single exercise for the variety of con-
figurations encountered in school settings.

Adding a Picture in Outlook on the Web
Complete these steps to add a photo of yourself to your profile on the Exchange 
server if no picture is present:
 1. Open a browser window, navigate to the URL for Outlook on the web 

provided by your mail administrator, and then sign in to your account.
 2. Click the image control near the top right of the browser window and then 

click Change below your name and email address in the drop-down list.
 3. Click the Choose photo control (displays as a file folder) in the right pane.

 4. At the Choose File to Upload dialog box, navigate to the drive and/or folder in 
which the desired image file is stored and then double-click the file name for 
the photo.

 5. When the photo finishes uploading and the thumbnail image appears in the 
image control in the right pane, click the Save button.

Click the image control and then 
click Change to add a picture to your 
Exchange server account profile.

Next, click the Choose photo control.

Click the Save button 
when the photo appears 
in the image control.
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Adding a Picture to Your Microsoft Account Profile
Complete these steps to add a photo of yourself to your Microsoft account 
profile, which also displays your photo in other Microsoft applications:
 1. Open a browser window and go to Outlook.com.
 2. If necessary, sign in to your Microsoft account.
 3. Click your name or image control near the top right of the browser window 

and then click Edit profile at the drop-down list.
 4. Click Change picture at the Profile page.
 5. Click the Browse button next to the Choose picture text box.

 6. At the Open dialog box, navigate to the drive and/or folder in which the 
desired image file is stored and then double-click the file name for the photo.

 7. If necessary, drag the image 
inside the box in the larger-
sized preview to choose the 
area for your picture that 
you want to show. Watch the 
image in the smaller-sized 
preview to help you choose 
the area.

 8. Click the Save button when 
finished.

 9. Click the Microsoft Apps 
button (Waffle icon) to go 
back to the Outlook.com 
inbox.

Click your name or the 
image control and then 
click Edit profile to add a 
picture to your Microsoft 
account profile.

Next, click Change picture.

Click the Browse button 
to locate and select the 
picture.

Drag the image inside the preview box 
until the smaller-size preview at the 
top left displays the desired area, and 
then click the Save button.




